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At our January meeting we will be serving hot cider 
and snacks. It will be a chance to take time to get to 
know each other better. Come with some ideas for 
topics for meetings for the new year. If you received 
the gift of a techie gadget be sure to bring it for show 
and tell. 
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TC/PC 

Business 
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Friendship Village 

 

Metro Sales 

 

Thank You! 

The Digital Viking 
 The Digital Viking is the official monthly publication of 

the Twin Cities PC User Group, an all-volunteer organization 

dedicated to users of IBM-compatible computers. Subscriptions 

are included in membership. We welcome articles and reviews 

from members. The Digital Viking is a copyrighted publication 

and reproduction of any material is expressly prohibited without 

permission. Exception: other User Groups may use material if 

unaltered and credited. 

 Disclaimer: All opinions are those of the authors and do 

not necessarily represent the opinions of the TC/PC, its Board of 

Directors, Officers, or newsletter staff. TC/PC does not endorse, 

rate, or otherwise officially comment on products available; 

therefore, readers are cautioned to rely on the opinions presented 

herein exclusively at their own risk. The Digital Viking, its 

contributors, and staff assume no liability for damages arising out 

of the publication or non-publication of any advertisement, 

article, or other item. All refunds in full or in partial, for advertis-

ing, membership or any other item shall be at the sole discretion 

of the Twin Cities PC User Group Board of Directors. 

 

Advertising 
Full page (7½ x 9½) $100.00 

Two-thirds page (7½ x 6) 80.00 

Half page (7½ x 4¾) 65.00 

One-third page (7½ x 3) 50.00 

Quarter page (3½ x 4¾) 40.00 

Member Bus. Card (2 x 3½) 10.00 

Multiple insertion discounts available. 

Contact Sharon Walbran at:: SQWalbran@yahoo.com 

Deadline for ad placement is the 1st of the month prior to publica-

tion. All rates are per issue and for digital or camera-ready ads. 

Typesetting and other services are extra and must be requested in 

advance of submission deadlines. 

Payment must accompany order unless other arrangements are 

made in advance. Place make checks payable to: Twin Cities PC 

User Group 

TC/PC 2011-2012 Board of Directors 
 

Meets second Thursday of each month at 7:00 PM. All members welcome to attend. 

Call Ross Held (612-386-3172) for meeting details. 

President —Jim Grotz jim.grotz@raymondjames.com 

Vice President —Curt Trout ctrout@troutreach.com 

Secretary - Sharon Walbran sqwalbran@yahoo.com 
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Newsletter Publisher Sharon Walbran 952-925-2726 SQWalbran@yahoo.com 

Web Master Jack Ungerleider jack@jacku.com  

Jeannine Sloan Ambassador for Friendship Village 

Ron Bruncati 612-377-7936 brunron@mtn.org 

Joel Hedland joelh@spacestar.net 

Jim Schlaeppi jschlaeppi@charter.net 
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Gary Grau    oxygary2389@yahoo.com 

Ross Held    RHeld3745@aol.com 
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FREE ½ page ad on  
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20% discount on all ads 
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Up to 5 newsletters mailed to 

your site 

(only a nominal cost for each 

additional 5 mailed) 

Newsletter Staff 
Editor Sharon Walbran 

Contributors: 

Jeannine Sloan 
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WEBSITES: 
https://www.ghostery.com 
 
https://addons.mozilla.org/en-US/firefox/addon/betterprivacy/ 
 
http://www.pewinternet.org/Reports/2012/Teens-and-Privacy.aspx 
 
http://www.pewinternet.org/~/media//Files/Reports/2012/PIP_ParentsTeensAndPrivacy.pdf 
 
https://en.wikipedia.org/wiki/Tracking_cookies 
 
https://en.wikipedia.org/wiki/Web_beacons 
 
https://en.wikipedia.org/wiki/Local_shared_object 
 

I frequently hear about internet users who always clean all of their cookies citing fears of privacy 
issues or identity theft.  If I ask some of those users "What is an internet cookie?" I receive a variety 
of replies indicating a multiplicity of definitions varying from somewhat accurate to wildly inaccurate.  
There is equal misunderstanding about the functions of cookies, and the degree of risk that they 
pose to the user.  When I ask users who faithfully clean their cookies for various reasons, I 
sometimes ask if they also delete their LSO or "Local Shared Object" cookies as well, which is 
typically responded to with a blank stare. 

Cookies have been around since the early days of the World Wide Web, first used in beta 
version of Netscape in 1994, and are by default saved by most browsers.  According to Wikipedia, " 

A cookie, also known as an HTTP cookie, web cookie, or browser cookie, is usually a small piece of 
data sent from a website and stored in a user's web browser while a user is browsing a website."  
These are small text files, not to exceed 4kb in size.  By themselves, cookies are inert pieces of data 
that cannot transmit viruses, and cannot infect the computer with malware.  Some cookies are 
beneficial for the user while other cookies may be used to track the users' web surfing habits, a 
major privacy concern. 

Some of the good or beneficial cookies are used as shopping carts which temporarily store a list 
of items being purchased online from a particular website; other beneficial cookies are referred to in 
the trade as "authentication cookies" which indicate to a website the authenticity of a user often 
including an encrypted username and password when a user clicks "Remember Me" on a website, 
allowing the user future access without the need to login.  In some cases, if an authentication cookie 
is not properly encrypted, it can be read by a hacker, which will then give the hacker access to the 
user's web account on that particular website; while this has indeed occurred, it is not considered to 
be a common threat at present due to the security enhancements built into all modern browsers. 

The most controversial type of cookie, one that has attracted the ire of regulators in the U.S. and 
Europe, is the tracking cookie, called by some a "persistent cookie".  Wikipedia describes them as, 
" ... tracking cookies and especially third-party tracking cookies are commonly used as ways to 
compile long-term records of individuals' browsing histories. ... Advertising companies use third-party 
cookies to track a user across multiple sites. In particular, an advertising company can track a user 
across all pages where it has placed advertising images or web bugs. Knowledge of the pages 
visited by a user allows the advertising company to target advertisements to the user's presumed 
preferences."  Many users actually benefit to some degree by having some tracking cookies on their 

Who Is Tracking What You Do Online? 
by Ira Wilsker, iwilsker(at)sbcglobal.net 

https://www.ghostery.com
https://addons.mozilla.org/en-US/firefox/addon/betterprivacy/
http://www.pewinternet.org/Reports/2012/Teens-and-Privacy.aspx
http://www.pewinternet.org/~/media/Files/Reports/2012/PIP_ParentsTeensAndPrivacy.pdf
https://en.wikipedia.org/wiki/Tracking_cookies
https://en.wikipedia.org/wiki/Web_beacons
https://en.wikipedia.org/wiki/Local_shared_object
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computers, as the advertisers who financially support the websites that we visit (and keep them free 
for us) can better and more efficiently target advertising to the user.  A recent study by McCann 
Truth Central covering internet tracking found that 69% of respondents surveyed indicated that they 
believe that they get better discounts and promotions; 42% appreciate the targeted advertising that 
displays items of interest to them; 32% appreciate the convenience and ease of checkout because 
sellers already have information on them; and 24% like the fact that these targeted advertisements 
display items of interest that the users were unaware of.  According to McCann, "Folks around the 
globe are more than willing to share their personal information as long as there’s something in it for 
them.  The more the benefits, the more information they’ll share."  Seven out of 10 of the people 
asked said they were willing to share their personal information when it meant they had access to 
promotions and discounts. 

There are also inherent risks with tracking cookies, in that they may be used to violate the web 
surfer's privacy, in that third parties often compensate websites for planting their cookies on users' 
computers.  It is the compilation of the websites visited and unknowingly disclosed to third parties 
that invokes privacy fears, in that your personal profile is being developed and read by others for a 
variety of legitimate and illicit purposes.  With tracking cookies it is easy to determine many of an 
individual's demographic characteristics including race, gender, income, marital status, political 
affiliation, sexual orientation, hobbies and interests, religion, and other facets of life that we prefer to 
keep private. 

Some tracking cookies are sneaky in the way that they are placed on the computer by websites 
that have been visited.  These "web bugs" are also called web beacons, tracking bugs, tags, and 
other somewhat descriptive names.  In order to slip through some forms of browser security, the 
web bugs are actually a tiny GIF file, consisting of a single pixel (the tiny dots that make up the 
image on your monitor are pixels or "Picture Elements").   The miniscule images are sometimes 
called a tracking pixel, pixel tag, or a 1×1 gif.  Since browsers are designed to display GIF and other 
common image formats, a web bug or GIF image of a single pixel will be virtually invisible to the 
user when displayed on a web page.  Most users are oblivious to the fact that most browsers, again 
by default, respond to images displayed by transmitting back to the sender of the web bug 
information culled from the user's browser, including operating system, IP address, and other 
information that in some cases could also include the user's name.  Since almost all email programs 
support HTML based email, web bugs are frequently used by spammers to report back to them 
when the recipient of the spam email opens  the spam before deleting it.  Now the spammer has a 
confirmation of the target's email address, as well as the ability to gather additional information from 
the recipient's computer. 

Another type of tracking cookie, the one that most internet users are totally unaware of, is the 
LSO or "Local Shared Objects" which are not the typical text based cookie, or the common variety 
of web bug, but instead are cookies written in Adobe Flash, which are undetectable by most users 
and cookie cleaning utilities.  According to Wikipedia, "Local shared objects contain data stored by 
individual websites. With the default settings, the Flash Player does not seek the user's permission 
to store local shared objects on the hard disk."  While the traditional text based cookie is generally 
limited to 4kb in size, these LSO or flash cookies can be up to 100kb in size, thus capable of storing 
much more information about the user and the websites visited.  Unlike common cookies, which are 
all connected to a specific browser, the one which wrote them to the hard drive, LSO cookies are 
independent of the browser, thus can be shared (read) by any browser on the computer.  For 
example, if I receive an LSO cookie while browsing with Firefox, and later open Internet Explorer, 
the LSO cookies written by Firefox will also be accessible to Internet Explorer.  With Internet 
Explorer open, websites can read the LSO cookies received earlier by Firefox, allowing targeted 
advertising, dynamic content, or other forms of targeting just as if I still had Firefox open. 
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Almost all contemporary browsers offer a "Do Not Track" function (also listed as "DNT") in their 
privacy settings.  In theory, this tells websites not to track this particular user; while some websites 
honor this request, many do not, making this function somewhat dubious in the browsers, but still 
appropriate to select.  Also in the privacy settings are usually displayed the options available for 
dealing with traditional cookies; the user can reject all cookies or selectively accept some cookies.  
While it may already exist, and will likely appear in upcoming browser releases, I have not yet seen 
a browser privacy option that blocks web bugs and LSO cookies. 

Since I value my privacy, and primarily use the latest version of Firefox on all of my PC's, I use a 
variety of utilities  to control the placement of tracking cookies, web bugs, and LSO cookies on my 
computer.  A cute little free program called Ghostery (www.ghostery.com) can detect the different 
varieties of web bugs and web beacons as well as the tracking cookies on any website visited, 
displaying all of them to the user immediately after opening a webpage, thus allowing the user to 
take control over what is placed on his computer.  Ghostery is available (free)  for Firefox, Safari, 
Chrome, Opera, Internet Explorer, and iOS devices  (iPhone and iPad versions).  I also use a 
Firefox add-on BetterPrivacy (addons.mozilla.org/en-US/firefox/addon/betterprivacy) which deletes 
any LSO or Flash cookies that may have been loaded during a session, automatically deleting them 
when closing Firefox. 

Being aware of the types of privacy issues that may arise from online tracking, and how tracking 
devices  may be used or abused by others, the user can better control who has access to his 

internet website history, and what they can do with it.Go to Page 1 

Blogs Worth Following 
By Sharon Walbran, TC/PC User Group, SQWalbran(at)yahoo.com 

Online blogs can be a great source of technical information for the computer user. Blogs offer tips 
and tricks for new users, how to program articles for the experienced computer user, and product 
reviews and updates. You can read blog entries as often as you choose by visiting the blog site or you 
can sign up to be notified via Facebook every time a new post is published. You can also leave 
comments on blog sites and provide feedback to the blogger. Some blog sites have chat rooms as well. 

Here are some tech blogs you can visit to get started: 
ZDNet, www.zdnet.com, from Ziff-Davis Publishing, has been publishing technical articles since the 

dawn of personal computers. The team of writers posts new articles and blog entries very frequently. If 
you want to keep up with the latest products and the current news in technology this is the site to visit. 
Some recent articles include: “Year in Review: Windows 8, roadmaps, Office Next top the reader charts” 
and “LG Display bringing Retina Display-like resolution to 7-inch tablets, 12.9-inch laptop screen.” Other 
well-established publishers include Wired, www.wired.com, and CNET, www.cnet.com. 

How to Geek, www.howtogeek.com, offers step-by-step instructions for using your computer 
hardware and software. The explanations are well-written and easy to follow. Recent articles include: 
“How to Use the Advanced Start up Options to Fix Your Windows 8 Computer” and “How to Access 
Windows Remote Desktop Over the Internet.” 

Digital Inspiration, www.labnol.org, written by Amit Agarwal from India, covers computer tips and 
tricks. Recent articles include: “Send a Free Fax to Anywhere in the World [using Windows]” and “Keep 
Your Google Contacts Up-To-Date with a Google Script.” 

Mashable, www.mashable.com, covers a broader range of topics not just tech topics. Recent articles 
include: “What to do with your Android” and “This is How Your DSLR Camera Actually Works.” 

Make Use Of, www.makeuseof.com, provides tips and hacks. Recent articles include: “How to Break 
the DRM on Kindle eBooks so You Can Enjoy Them Anywhere” and “Windows Phone 8 vs. Windows 
Phone 7.8, What’s the Difference and Should You Upgrade?”  

These represent just a fraction of the blogs available. There’s one out there that will suit your needs. 

http://www.ghostery.com
addons.mozilla.org/en-US/firefox/addon/betterprivacy
http://www.zdnet.com/
http://www.wired.com
http://www.cnet.com
http://www.howtogeek.com
http://www.labnol.org
http://www.mashable.com
http://www.makeuseof.com
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  By Jeannine Sloan 

Webmail Attachments Made Easy  
In some Web browsers, both Yahoo Mail and Google’s Gmail allow you to drag files from your 
computer’s desktop right into the message window to upload them as file attachments. Yahoo has 
additional information on attachment management and Google has an illustrated example for 
Gmail.  
 

Web Site Recommendation  
Hundred Zeros is a frequently updated catalog of best-sellers that are free on Amazon. The 
authors have created an easy-to-use interface for browsing books. You can also download and 
read Kindle eBooks on your computer, mobile phone, tablet, or the browser. http://
hundredzeros.com/ 
  

Add Shortcuts to Web Sites on Tablet Home Screen  
In the Safari toolbar tap the Share menu icon which looks like an arrow bursting out of a rectangle. 
On the menu that appears, tap the “Add to Home Screen”  
In the Android Browser find the bookmark that you’d like to add to your home screen and press 
down on it until a new menu appears. Tap the “Add shortcut to Home” option.  
From NY Times Gadgetwise blog  
 

Figuring Out a Wireless Password in Windows 7  
With the permission of the network owner you can connect to a friend’s network with Windows 7 
even if they cannot remember the network key.  
Go to the Network and Sharing Center in the Windows Control Panel.  

Click on “Manage Wireless Networks.”  

Scroll to the network whose key you wish to know and right click to access the “Properties” menu.  

Click on the Security tab.  

Click on “Show Characters” underneath the input box for the password.  
From PCMech ezine  

 

History  
In 1983 IBM introduced Personal Computer XT which offered something no other consumer 
computer had ever offered before: an internal hard drive. One 10MB drive, massive and pricey for 
its day, came standard with every IBM PC XT. That’s not all the $5,000 MSRP got you though, the 
machine also shipped with 128KB of RAM and a 360KB 5-inch floppy drive as well as a 
monochromatic CRT monitor and one of IBM’s beloved Model M mechanical keyboards.  
 

Past Issues of NIBBLER  
Missing an issue of the NIBBLER? They are reprinted in the TCPC newsletter “The Digital Viking”. 
Many past issues of the Viking can be found at http://tcpc.com/newsletters 

http://hundredzeros.com/
http://hundredzeros.com/
http://tcpc.com/newsletters
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How to Power Cycle Your Gadgets to Fix Freezes and Other Problems 
Have you ever had a smartphone, laptop, tablet, or any other electronic gadget become unresponsive? 
The surefire way to recover from the freeze – assuming it’s not a hardware problem – is by power-
cycling the gadget. http://www.howtogeek.com/131148/ 
 

POP 
POP (Post Office Protocol) supports simple download-and-delete requirements for access to remote 
mailboxes. Although most POP clients (Outlook, Outlook Express) have an option to leave mail on 
server after download, e-mail clients using POP generally connect, retrieve all messages, store them on 
the user's PC as new messages, delete them from the server, and then disconnect. http://
en.wikipedia.org/wiki/Post_Office_Protocol#See_also 
 

Clean Touch Screen 
Keep a touch screen free of smudges and fingerprints is by using a microfiber cloth. These and are 
gentle, yet effective in keeping your work and viewing surface clean and clear. 
 

Google Earth used by Archeologist 
Google earth was used to discover the fossil of an ancient hominid. Read the story in the book “The 
Skull in the Rock” from NGS (National Geographic Society). Check it out if you are interested in 
archeology. Don’t be put off by the fact that it’s a children’s book. 
 

Turn OFF Wi-Fi to Conserve Battery 
On tablets and smart phones searching for Wi-Fi shortens battery life in a really big way. If you're going 
to be reading an ebook, listening to music or watching a movie on internal storage, there's no reason to 
have Wi-Fi humming along stealing precious battery juice. Find the setting to turn it OFF. 
 

Quick Parts 
Add a field to a Word 2010 document that will change the output each time the document is printed. Go 
to the Insert tab, Text group, Quick Parts item and click on “Field”. Click each drop down arrow to see 
lists of the information that can be automated. Detailed instructions here: http://tinyurl.com/a7bxh7p 
 

Turn Paint Chips into a Dry Erase Calendar 
You need 35 chips, a 12" x 16" frame, and a dry erase marker to create your own version. 
From Lifehacker 
 

Convert Print Books to Digital 
1DollarScan is a service that will take your books (hardback and paperback), magazines, and other 
business documents and convert them for you at very reasonable prices. The result is a PDF file. A 
review of their services is here: http://www.wired.com/geekdad/2012/12/stacks-with-1dollarscan/ 
 

Guide to Types of Household Batteries 
I love comparison charts and this one is worth bookmarking. http://michaelbluejay.com/batteries/ 
 

Basic Wildcard Search in Word 
Search using the ? character in Word 
Summon the Find and Replace dialog box. 

If necessary, click the More button to display the Search Options area. 

Select the Use Wildcards option. 

http://www.howtogeek.com/131148/
http://en.wikipedia.org/wiki/Post_Office_Protocol#See_also
http://en.wikipedia.org/wiki/Post_Office_Protocol#See_also
http://tinyurl.com/a7bxh7p
http://www.wired.com/geekdad/2012/12/stacks-with-1dollarscan/
http://michaelbluejay.com/batteries/
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In the Find What box, type text containing the question mark (?) wildcard. 
 
For example, if you type ?up, then Word searches for three-letter words in your document that start with 
any old letter but must end with “up,” such as cup and pup. 
Search using the * character in Word 2007 
Summon the Find and Replace dialog box. 

If necessary, click the More button to display the Search Options area. 

Select the Use Wildcards option. 

In the Find What box, type text containing the asterisk (*) wildcard. 
 
The asterisk finds a group of characters. For example, if you type w*s, then Word locates any word 
starting with w and ending with s, such as words and welcomes. 
From Dummies ezine 
 

Definitions 
Power Cycling: Cutting the power to a device, then restoring the power. 
UPS: UPS stands for “Uninterruptible Power Supply.” 

 

Quick Tips 
You can double-click a word to highlight it in any document, e-mail or Web page. 
You can tap the Space bar to scroll down on a Web page one screenful. Add the Shift key to scroll back 
up. 
When you’re filling in the boxes on a Web page (like City, State, Zip), you can press the Tab key to jump 
from box to box, rather than clicking. Add the Shift key to jump through the boxes backwards. 
Forcing the cameras flash to go off prevents silhouetted, too-dark faces when you’re outdoors. 

 

Convert an Old Nook Tablet to Android 
An unused Nook can be converted to an Android tablet using free, downloadable conversion software or 
you can get a SD card from: n2acards.com. Some people would say that N2A is a scam (since they are 
basically just offering, for a price, a bootable CyanogenMod SD card) but they make the process easier 
for the less tech-savvy people. http://n2acards.com/ 
 

Windows 8 
Microsoft’s new OS is out. On new equipment it comes with a touch screen, which means that the 
controls are gesture based. This site presents a printable chart of gestures and what they do: http://
windows.microsoft.com/en-US/windows-8/touch-swipe-tap-beyond 
 

Windows 8 Without a Touch Screen 
Windows 8 installed on an older machine that does not have a touchscreen is easy to use, too. Simply 
control the pointer with a mouse and it does the same things as a gesture does on a touchscreen. 
Whether or not a touchscreen is available it will be easier if you know a few keyboard shortcuts. The 
ones you already know will probably work so try them first. There are some new ones that are unique to 
Windows 8. Here are a few new ones will get you started: 

Win + R and type in “recent“ and hit Enter. There you can see your recent activities. 

Win + Q Access the Apps Search screen 

Win + F Access the Files Search screen 

Win + X Access the Windows Tools Menu 

http://n2acards.com/
http://windows.microsoft.com/en-US/windows-8/touch-swipe-tap-beyond
http://windows.microsoft.com/en-US/windows-8/touch-swipe-tap-beyond
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Windows 8 
Microsoft’s new OS is out. On new equipment it comes with a touch screen, which means that the 
controls are gesture based. This site presents a printable chart of gestures and what they do: http://
windows.microsoft.com/en-US/windows-8/touch-swipe-tap-beyond 
 

Windows 8 Without a Touch Screen 
Windows 8 installed on an older machine that does not have a touchscreen is easy to use, too. 
Simply control the pointer with a mouse and it does the same things as a gesture does on a 
touchscreen. 
Whether or not a touchscreen is available it will be easier if you know a few keyboard shortcuts. 
The ones you already know will probably work so try them first. There are some new ones that are 
unique to Windows 8. Here are a few new ones will get you started: 

Win + R and type in “recent“ and hit Enter. There you can see your recent activities. 

Win + Q Access the Apps Search screen 

Win + F Access the Files Search screen 

Win + X Access the Windows Tools Menu 
 
The Windows Tools Menu incorporates accelerator keys. Notice each entry in the list has one 
underlined key that is the accelerator key. Simply tap that key on the keyboard to open the option. 
That is enough to get going but if you want more shortcuts download the following sheet. 
 

100 Windows 8 Keyboard Shortcuts 
TechRepublic’s Greg Shultz has compiled a set of 100 Windows 8 keyboard shortcuts that will help 
you more quickly and efficiently navigate Windows 8 and its new Metro User Interface. 
Some of the keyboard shortcuts found in the free to download PDF are familiar to users of 
Windows 7, but there are also many shortcuts that are particular to Windows 8. 
http://www.windows8update.com/2012/04/10/techrepublic-offering-pdf-with-100-windows-keyboard-
shortcuts/ 

 
 
Happy New Years to Jeannine. Looking forward to another year of Nibblers. 
 
 
Go to Page 1 

http://windows.microsoft.com/en-US/windows-8/touch-swipe-tap-beyond
http://windows.microsoft.com/en-US/windows-8/touch-swipe-tap-beyond
http://www.windows8update.com/2012/04/10/techrepublic-offering-pdf-with-100-windows-keyboard-shortcuts/
http://www.windows8update.com/2012/04/10/techrepublic-offering-pdf-with-100-windows-keyboard-shortcuts/
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Special Interest Groups (SIGs) 
 

Most SIGs will meet at Edina Executive Plaza, Conference Room #102, 5200 Willson Road, Edina, MN 

 Confirm with a SIG group if they meet elsewhere. 

For more info contact the SIG Leader(s) listed here. 

 w Work phone    h Home phone   c Cell phone 

 * Meets at an alternate location 

Get SIG announcements! 

Link from www.tcpc.com 

Directions to Edina Executive Plaza 

for Systems on Saturday, Access,  

Word and Picture Perfect SIGs: Take 

Highway 100 to the 50th Street/Vernon 

exit. [If you have come from the north, 

cross back over Highway 100 to the 

east side.] Take the first right and go 

past Perkins [The golf course will be on 

your left.] and continue on the east 

frontage road (Willson Road) to the 

next building—5200 . There is ample 

parking in the building’s lot. 

Conference Room #102 is on 1st floor. 

Microsoft Access 
All levels. Presentations by expert develop-
ers within the group and by MS reps. 
Third Saturday 9:00 AM—Noon 
 
Steve Kuhlmey 952/934-8492 
 steve@kuhlmeysystems.com 
 

Microsoft Office 
Addresses the use, integration, and nuanc-
es of the Microsoft Office applications. 
Combined with Systems on Saturday 
Third Saturday of the Month  
 
Steve Kuhlmey 952/934-8492 
 steve@kuhlmeysystems.com 
 

Web Page Design 
Discussion and demonstration of HTML, 
web publishing software and page design. 
 
Second Tuesday @ 6:00-7:00 PM 
Every other month 
Right before the general meeting. 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 

Microsoft Word for PC & Mac 
Any level user can be proficient and efficient 
in basics and advanced features of Word.. 
Combined with Systems on  
Third Saturday 9:00 AM—Noon 
 
Tom Ostertag 612/951-5520 w 
 651/488-9979 h 
Curt Trout 651/484-4569 h 
 ctrout@troutreach.com 
 

Systems on Saturday 
For all levels of computer challenges and any 
type of computer-related question. Incl. Q&A 
Meets 2nd & 3rd Saturdays 9:00 AM-Noon 
 
Curt Trout 651/484-4569 h 
 ctrout@troutreach.com 
 

Directions to Summit Place for General Meetings: 

Proceed to Eden Prairie Center Flying Cloud Drive . [Flying Cloud Drive runs along 

the West side of the Eden Prairie Center.]  Once you have driven past Eden Prairie 

Center (on the left) along Flying Cloud Drive you will come to a stop light at Prairie 

Center Drive.  The next intersection with a stop light and left turn lane is Fountain 

Place. Turn left at Fountain Place and go straight into the parking lot. Turn left again 

to the first covered entry way of Summit Place.  There is plenty of parking in the 

large parking lot in front of the first Summit Place covered entry way.  When you 

enter the door at the first covered entry way, ask to be directed to the Performance 

Room for the TC/PC meeting.  For a map of more detailed directions and info on 

Web SIG and Board meeting, check the TC/PC website. 

Board of Directors* 
All members are welcome! Call for location. 
Selected Saturday mornings 
 
Ross Held RHeld83745@aol.com 

 
 
Community Outreach* 
To request services or volunteer to help  
Contact: 
Ross Held RHeld83745@aol.com 
 

Linux on Saturday 
This is for the Linux newbie and those trying 
to come over from Microsoft to a different 
operating system. 
Second Saturday @ 9 AM-Noon 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 
 

Picture Perfect 
Explore how to use your digital camera 
and learn how to use a variety of software 
for editing, organizing, and sharing images 
and video. 
Second Tuesday 6:00—7:00 PM 
Every other month 
Right before the general meeting 
Sharon Walbran    SQWalbran@yahoo.com 

Help yourself by helping others! 

Join the team & share your knowledge with others. 
Contact TC/PC at www.tcpc.com 

http://www.tcpc.com
http://www.tcpc.com
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(including 
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Open Source 
on Saturdays 
9:00—Noon 

10 11 12 General Mtg 
7:00 PM 
6:00 Pic Perf SIG 

13 14 15 16 Windows 

& MS Office 
(including 
Access) 
9:00-Noon 
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In these days when almost everyone is using a computer, there are many features of operating 
systems and software that can help users with physical limitations. Microsoft has enhanced its 
features in this area, both in Windows 7 and recent versions of Microsoft Office. This article gives an 
overview of these features and links to some helpful sites for people interested in making the tools 
work for them. In Windows 7, the accessibility tools are found in the Ease of Access Center (Start – 
Control Panel – Ease of Access Center). These tools are designed to help people who have 
problems with vision, hearing, and dexterity. 

 
Low Vision and Blindness 

For the person who finds the computer display hard to read, changing a few settings in the Ease 
of Access Center can make life easier.  You can select a High Contrast theme which shows either 
white text on a black background or all bold black text on a white background for all text, including 
toolbars and ribbons. This feature is especially useful for users with conditions like macular 
degeneration. The Magnifier tool enlarges the portion of the screen where the mouse pointer is 
located, a lifesaver when trying to read small text in a document or on a webpage. Like other tools, it 
can be pinned to the taskbar for easy access. Other settings let you remove unnecessary 
background images or animations, make the flashing cursor thicker and more visible when typing, 
and sharpen the appearance of window borders to make them easier to see. 

A person who is blind can work with a Windows computer through a combination of the Narrator 
and Voice Recognition tools using speakers and a microphone. Narrator reads text aloud as it 
appears on the screen and describes things like error messages. The Voice Recognition tool, 
introduced in Word 2010, translates the user’s speech into text on the screen. It does need initial 
setup, involving training the tool to understand the user’s vocal patterns. Another tool, Audio 
Description, gives oral narration of the action in videos. 

 
Limited Dexterity 

A number of tools are designed to assist the person with limited finger dexterity. Turning on the 
Mouse Keys lets you move the pointer on the screen using the arrow keys instead of the mouse. 
Sticky Keys let you press keystroke combinations, such as Ctrl+Alt+Del, one key at a time. Toggle 
Keys play an alert sound when you press the Caps Lock, Num Lock or Scroll Lock keys, saving you 
from unanticipated results like a sentence in all caps. Filter Keys can be set to ignore unintentional 
keystrokes, such as several in rapid succession or holding down a key for an unusually long time. 

The Voice Recognition tool, besides assisting blind users, is also useful either for those with 
limited dexterity or inadequate typing skills. The on-screen keyboard lets the hunt-and-peck typist 
click letters on a keyboard displayed on the screen. For those who have trouble maneuvering a 
mouse, one solution is to develop the habit of using keyboard shortcuts in place of mouse clicks. 
Searching the Internet will provide lists of standard keystroke shortcuts; you can also create your 
own. Windows. Ease of Access Center also has features that can help. One option lets you hover 
the mouse pointer over a window to open it, rather than clicking. Other settings for the mouse use 
can be found in the Control Panel - Mouse. Here you can change the speed of the mouse click and 
create a trail of pointer images behind the moving pointer to keep it in view. You can also change 
the shape and size of pointer icons. 

 
 

Making Your Computer Easier to Use 
Nancy DeMarte, Regular Columnist (Office Talk), Sarasota PCUG, Florida, May 2012 issue, 
Sarasota PC Monitor, www.spcug.org, ndemarte (at) Verizon.net 

http://www.spcug.org/
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Hearing Loss 
Although computers are more visual than auditory, users with hearing loss need a few tools to 

assist them. In the Ease of Access Center, you can change alerts in many programs from sound to 
a text alert or a flash on the screen. Another setting displays text captions for spoken dialogue in 
multi media programs. 

 
Accessibility Features in MS Office 2010 

Microsoft Word, Excel, and PowerPoint 2010 have new features to help make documents, 
spreadsheets, and presentations more accessible to those with limitations. One is the Accessibility 
Checker. This tool diagnoses a file for any areas that might make it difficult to view or use. The 
author of the file can review the list and make any changes he feels are needed. Another new tool is 
Mini Translator, which translates a word or phrase from another language into English when the 
mouse points to it. Clicking the Play button lets you hear the word or phrase pronounced. Another 
feature new to Office 2010 is the ability to add text descriptions to shapes and images for those who 
can’t view them. Enlarging text in Word 2010 is easy with the zoom slider in the right bottom corner 
and a new full screen Reading View option which enlarges and sharpens document text. 
PowerPoint 2010 has added the capability to add closed captions to audio and video and embed 
them in a slide presentation. 

Windows is compatible with many third party assistive software programs and devices. MS 
Office 2003 –2010 users can turn documents into Talking Books by downloading the “Save As 
Daisy” add-in. Go to http://sourceforge.net and search for and download/install “Save As DAISY for 
Office (your version).” Then install a DAISY-compatible digital talking book reader, such as the free 
AMIS reader. www.DAISY.org/amis/download. Versions are available for Office 2007/2010 and for 
Office 2003 with the Office 2007 compatibility pack installed. Other requirements are listed at the 
sourceforge.net website. 
The number of options to increase accessibility to a computer can be overwhelming. This overview 
will make you aware of some of them, but only you can decide which ones you want to try. You can 
complete a short questionnaire in the Ease of Access Center to help with your decision. A few of 
these tools have a learning curve that can be greatly reduced by watching the video tutorials (some 
close-captioned) and reading support documents located at www.microsoft.com/enable/products/

office. Most can also be accessed directly from links in the Ease of Access Center. Fortunately, the 
support and setup tutorials for most of these tools are numerous and well done. More information 

can be found by searching www.microsoft.com/accessibility.Go to Page 1 

Get creative with Text Boxes 
Nancy DeMarte, Regular Columnist (Office Talk), Sarasota PCUG, Florida, September 2012 
issue, Sarasota PC Monitor, www.spcug.org, ndemarte (at) Verizon.net 

When you use Microsoft Office, you create and edit text all the time. Word, of course, is 
dominated by text; Excel and PowerPoint both use text in many of their functions. All recent 
versions of Office also include a tool called a “text box” for special uses of text. Let’s find out what it 
is and how to use it. 

A text box is a specialized shape in which you can enter text. It functions outside the regular 
margin constraints of a document and can be moved or resized as needed. A text box is useful for 
adding a caption to a photo or annotating a diagram or chart. If you want to emphasize an important 
statement in a document, you can use a text box to repeat the statement in a “pull quote” and locate 
it in an unexpected spot, such as along a margin (known as a Sidebar) or across columns in the 

file:///C:/Users/sharondell/Documents/My%20Documents/TCPC%20News/2012.10/www.DAISY.org/amis/download
file:///C:/Users/sharondell/Documents/My%20Documents/TCPC%20News/2012.10/www.microsoft.com/enable/products/office
file:///C:/Users/sharondell/Documents/My%20Documents/TCPC%20News/2012.10/www.microsoft.com/enable/products/office
file:///C:/Users/sharondell/Documents/My%20Documents/TCPC%20News/2012.10/www.microsoft.com/accessibility
http://www.spcug.org
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document. Its flexibility makes a text box useful in many situations. 
Text boxes have most of the same properties as shapes. In Word 2007 and 2010, when you click 

the Insert tab, then Text Box, you open the Text Box gallery of 36 preformatted text boxes, as well 
as the “Draw text box” option. If one of the preset boxes meets your needs, click to insert it into the 
document. Older versions of Word lack this gallery, but you can still draw a text box, which is most 
often my choice. Click “Draw text box” at the bottom of the gallery. Then click anywhere in your 
document where you want the text box to appear and drag diagonally down the page to the right to 
create the text box. At first the box covers a portion of the normal text. This is because the default 
text wrapping setting is “in front of text.” If you don’t want the text box to hide the document text, 
select the text box so “handles” appear around the box. At this point, the Text Box Tools Format tab 
appears on the ribbon. Click Format, and then Text Wrapping in the Arrange group. Change the 
setting to Tight, which will position the text box within the existing text and also allow you to move 
the text box. Do this by clicking an edge so a crossed arrows icon appears and dragging it to a new 
location. You can also resize the box by dragging an edge or corner. To enter text in the box, 
replace the informational text with your own. 

Once a text box is created and located in the document, it can be formatted in many ways. To 
format the text, select it, and a small version of the Font group on the Home tab will appear. Use 
these tools to change the font style, size, color, and other attributes. (You can also click the Home 
tab and use the full set of options in the Font group.) To format the text box itself, select it and use 
the tools on the Text Box Tools Format tab. For example, you can fill the box with a color, remove or 
change the border styles, make the text read vertically, or add special 3-D effects. 

In Office 2007 and 2010, text boxes are not limited to a rectangular shape. You can add text to 
any of the items in the shapes gallery. Click Insert – Shapes and click a shape. Click in your 
document and draw the shape in the same way you drew the text box. Change the text wrapping to 
Tight as you did above, then right click inside the shape and choose “Add Text.” The large number 
of shape choices gives you many options for text boxes. Another approach is to begin with a classic 
text box, even after it is filled with text. Select it, which opens the Text Box Tools Format tab. Click 
Format and select “Change shape,” which opens the shapes gallery. Click a new shape, and the text 
box transforms into that shape with all its contents intact. Another interesting possibility is inserting a 
photo or piece of clip art into a text box. With the text box or shape selected, click the Insert tab – 
Picture. Click the photo you want, then Insert. The photo appears in the text box, resized to fit. The 
same steps work to insert clip art, charts or tables within text boxes. 

Text boxes can be rotated for a dramatic effect. In Office 2010, select the text box, and click and 
drag the little green rotator circle above the box to rotate it left or right. In Word 2007, for an 
unknown reason, classic text boxes cannot be rotated, even though shapes can. One way to work 
around this problem is to create a text box, cut it using the Cut command on the Home tab, and then 
paste it as a “Picture (Windows Metafile)” using the Paste Special command option under the Paste 
icon. 

Occasionally, you might create a text box in Word that you’d like to reuse at a later time. You can 
save it by selecting the text inside the box and then clicking Insert and the arrow under the Text Box 
icon. Choose “Save Selection to Text Box Gallery.” 

Besides Word, text boxes appear in Excel and PowerPoint 2007/10. Neither program contains a 
text box gallery, but each has the “Draw a Text Box” tool, which gives you all the functions that Word 
does, including rotation. You can also start with a shape and include text by right clicking and using 
the “Edit Text” command. 

Have a little fun. Create a few text boxes in your next document, spreadsheet or presentation.
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You have just read an issue of The Digital Viking. 

 
Would you like to receive this delivered to your home or business each month? 

 
As a member of TC/PC, the Twin Cities Personal Computer Group, one of the benefits 

 is reading this monthly publication at www.tcpc.com.. 

 

As a member of TC/PC, you may attend any or all of the monthly Special Interest Group (SIG) meetings and be eligible for 

software drawings. The small membership fee also includes  

access to real-live people with answers via our helplines, discounts, and various other perks. 

 

Does membership in this group sound like a good way to increase your computer knowledge? 

 

It’s easy to do! Simply fill in the form below and mail it to the address shown. 

(If you use the form in this issue, you will receive an extra month for joining now.) 

 

 
Here’s the info for my TC/PC Membership: 
 

Full name_____________________________________________________ 

 

Company name________________________________________________ 

 

Address______________________________________________________ 

 

City_______________________________ State_________ Zip__________ 

 

Home  Business  Change address: Perm. Temp. ‘til ___________ 

 

Home phone____________________  Work phone____________________ 

 

Online address(es) _____________________________________________ 

 

Where did you hear about TC/PC? _________________________________ 
 
 I DO NOT want any of my information disclosed. 

 I DO NOT want to receive any mailings 

 
Administrative Use Only     Rec’d_____________________  Chk#_______________ 

 1/13 
I’m signing up for: 
 

 Individual/Family Membership ($18) 

 Business Membership ($100) 

 Student [ID required] ($20) 

If an existing member your # __________ 

Make checks payable to: 

Twin Cities PC User Group 
341 County Rd C2 W 
Roseville, MN 55113 
 

http://www.tcpc.com 
 

 Check #__________  Bill me 

 New member  Renewal  Prior member 

I’m interested in: 

 Training classes  Volunteering 

 Special Interest Groups: New User, Access, 
etc. 

List here: 
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FIRST CLASS MAIL 
341 County Rd C2 W 
Roseville, MN 55113 

November 8, 2011 • 7 PM 

General Meeting 
 

The Microsoft Store 
 

The Microsoft Store 
162 South Avenue 

Mall of America 

More info: www.tcpc.com 
P 

January 8, 2013 

General Meeting 
 
 

Hot Cider Social 

 

Summit Place 
8505 Flying Cloud Drive  
Eden Prairie, MN 55344 

 

More info: www.tcpc.com 
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